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‎1 Introducing SCORBASE 1 

‎2.1 System Requirements 

1. Introducing SCORBASE 
SCORBASE for SCORBOT-ER 4u is a robotics control software package for robot programming and 
operation. SCORBASE for SCORBOT-ER 4u provides numerous features: 

 Communication with the robot controller over USB channel 

 Control and real-time status display of five robot axes, gripper and two peripheral axes 

 Full support and real-time status display of eight digital inputs, eight digital outputs, four analog 
inputs, and two analog outputs 

 Position definition and display as well as manual robot movement in reference to Joint Coordinate 
System (encoder units) 

 The Cartesian Coordinate System (X,Y,Z, Pitch and Roll) is used. 

 Robot movement definition as Go to Position, Go Linear, or Go Circular, with active speed 
settings in percentages (Availability depends on Experience Level setting.) 

 Default setting of 1000 positions and 10000 active program lines 

 Interrupt programming for handling responses to changes in digital input status 

 Variable Programming, in three levels of complexity, to moderate the learning curve. This makes it 
possible for beginners to start at a lower level, and advance through the levels, as they become 
more skilled in robotics programming. 

 Saving and loading projects 

 SCORBASE can be installed as part of RoboCell, an interactive graphic software package, which 
provides simulation of the robot and other devices in the workcell 

This manual describes all the features and operations for all Experience Levels of SCORBASE. When 
necessary, illustrations show the differences in the levels, and descriptions note the availability of options 
and commands. 
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‎2.1 System Requirements 

2. Starting SCORBASE 
The instructions in this chapter are for SCORBASE only.  

If you intend to install SCORBASE as part of the RoboCell software package, follow the instructions in 
Chapter 2, Starting RoboCell, in the RoboCell User Manual. 

2.1. SYSTEM REQUIREMENTS 

For best performance, the following system is recommended: 

 Intel Core i5 2400 GHz 2400 GHz or higher, equipped with CD drive   

 At least 1GB RAM (4 GB for Windows 7 and higher)  

 A hard drive with at least 200 MB of free disk space 

 A mouse 

 USB port 

 Windows XP/7/8/8.1/10 

Note: Your operating system might have additional hardware requirements. 

2.2. INSTALLING THE SOFTWARE 

The SCORBASE software is supplied on a CD which also contains RoboCell. Close any open applications 
before proceeding with the installation procedures. If you are about to reinstall the software, or install a 
newer version to an existing SCORBASE directory, it is recommended that you back up any existing user-
created files before you begin the installation. It is also recommended that you remove the previous 
SCORBASE version for Windows installation, using the software’s Uninstall utility.  

To install SCORBASE: 

1. Insert the CD into the CD-ROM drive to start the installation procedure. 

 If the procedure does not start, either: 

 From the Windows task bar, click Start | Run and type D:Setup  

(where D: is your CD drive),  

or  

 Using Windows Explorer, explore the CD drive and  

click  Setup. 
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‎2.2 Installing the Software 

2. Wait until the Welcome window is displayed. 

 

3. Click Next. The License Agreement window is displayed. 
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‎2.2 Installing the Software 

4. Review the Intelitek software license agreement. You must accept the terms of this agreement in 

order to proceed with the installation. To accept, choose Yes. The Software Selection Window is 

displayed.  

 

5. Select SCORBASE for ASRS 2X36u, SCORBASE for ASRS 36u, SCORBASE for ER 2u, SCORBASE for ER 

4u or SCORBASE for Mobile Robot. The robot that you select becomes the default robot while you 

are working in SCORBASE, although you can choose to open a new project and work with a 

different robot. See the Hardware Setup option in the Options Menu. Click Next. The Setup Type 

window is displayed. 
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‎2.3 Uninstalling the Software 

6. Select the desired language and click Next. The Choose Destination Location window is displayed. 

 

7. The default destination folder for the files is: 

\Intelitek\SCORBASE 

Click Next to accept the default, or click Browse to select another folder and then click Next. The 

Select Program Folder window is displayed.  

8. Click Next to complete the installation procedure. 

2.3. UNINSTALLING THE SOFTWARE 

To uninstall SCORBASE: 

1. In the SCORBASE program group, select UnInstall. 

2. Follow the instructions that are displayed on the screen. 

2.4. STARTING SCORBASE 

To start SCORBASE: 

1. Ensure that all the components to be used are installed and connected according to the 

installation procedures detailed in the User Manuals supplied with the robot and controller. 

2. Turn on the computer and the controller. 

3. Select Start | Programs | SCORBASE. 
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‎2.5 Quitting the Software 

4. Select the SCORBASE command. After initialization, this screen is displayed: 

 

If SCORBASE opens in Off-Line mode or the controller is not detected, the program loads and operate in 
Off-Line mode.  

Only one instance of SCORBASE can be active at a time. 

2.5. QUITTING THE SOFTWARE 

Stop the SCORBASE program (if running). If you have unsaved changes in the project, SCORBASE prompts 
you to save the changes before closing. 

To close SCORBASE (or its components), do any of the following: 

 From the Menu Bar, select File | Exit. 

 Click the Close box in the SCORBASE Title Bar. 

 Press Alt + F4. 
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‎3.1 The SCORBASE Window 

3. Menus Overview 

3.1. THE SCORBASE WINDOW 

The image below shows the SCORBASE opening screen. The screen comprises: 

 A Title Bar containing the screen name and the standard Windows controls for sizing and closing 
the application screen.  

 A Menu Bar containing all SCORBASE command menus and options. 

 A Toolbar containing icons for the most commonly used options.  

 A Status Bar displaying information regarding the SCORBASE software, modes of operation, 
current activity, etc. When you position the mouse over an icon, a description of the icon is 
displayed in the status bar. 

Note: The System menu (displayed by right clicking the Title Bar) contains the Always on Top menu item, 
enabling you to display the application on top at all times. 
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‎3.2 File Menu 

3.2. FILE MENU 

A SCORBASE project contains a program (SBP file), user-defined positions (PNT file), and a project data file 
(WS file). If RoboCell is also being used, the project includes the cell image (3DC file). Throughout this 
manual, the term “project” refers to the program positions (and image) files saved by the user as one 
entity. 

The File Menu is shown here: 

 

The File menu contains the standard Windows functions that allow you to open new or previously saved 
projects, save and close projects. You can print files containing robot programs and positions, and you can 
exit the software. 

File Menu Options 

Icon Option (Shortcut) Description 

 
New Project (Ctrl+N) Opens a new untitled project 

 

Open Project (Ctrl+O) 

 

Opens the Load Project window which lists SCORBASE files (without a virtual 
cell) 

 
Save Project (Ctrl+S) Saves the currently active project (program, positions and graphics) 

 Save Project As... Saves the currently active project under a new project name 
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‎3.2 File Menu 

File Menu Options 

Icon Option (Shortcut) Description 

 Close Project Closes the currently open project 

 New Script 
Opens Notepad for writing a new Visual Basic script. Save the file with a .VBS 
extension in the same directory as the SCORBASE project file. The best 
practice for naming the file is: <SCORBASE project name>.VBS.  

 Open Script Opens the File Selector box for opening an existing Visual Basic script file 

 Print Program Prints the program. (The Program window must be active) 

 Print Positions Prints the user-defined positions. (Positions Window must be active) 

 Print 3D Image Reserved for the RoboCell program option 

 Print Preview  
3D Image 

Reserved for the RoboCell program option 

 Print Charts 

Opens a dialog box to select the specific axis chart for display or printout. Only 

one axis can be selected at a time. See ‎3.9 Charts on page 19 for more 

information.  

 Print Preview Charts Displays the selected axis chart before printout 

 Import 3D Model Reserved for RoboCell program option 

 Edit 3D Model Reserved for RoboCell program option 

 View File 

Enables you to view a file from those listed: 

 SCORBASE programs (*.sbp) 

 Position data (*.pnt) 

When you select a file, a window opens displaying that file. This is useful for 
copying lines from another existing SCORBASE program into a program being 
written. 

 Exit 
Closes SCORBASE. If changes to a program or position file have been made but 
not yet saved, a message is displayed giving you the opportunity to save the 
file before you exit SCORBASE. 
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‎3.3 Edit Menu 

3.3. EDIT MENU 

The Edit menu contains the standard Windows functions that allow you to edit program files. 

 

The Edit Menu options are summarized in this table.  

Edit Menu Options 

Cut (Ctrl+X) 
Deletes selected text or lines from the program lines, and places it on the Windows 
and SCORBASE clipboards 

Copy (Ctrl+C) 
Places a copy of selected text or lines from the program lines on the Windows and 
SCORBASE clipboards 

Paste (Ctrl+V) Inserts the contents of the SCORBASE clipboard into the program lines 

Find (Ctrl+F) 
Opens a dialog box that allows you to search for a particular text string, SCORBASE 
command, or command argument 

Find Next (F3) Repeats the last Find operation for the next occurrence 

Command/Remark (*…) 
Inserts/deletes asterisk at beginning of a SCORBASE program command line. This 
action toggles the command line between a remark and an executable command.  

Go to Line… 
Opens a dialog box that displays the total number of lines in the program and 
prompts you for a line number. The program editor jumps to the line you specify.  

Go to Selected Line Display the line selected. This is useful for long programs.  
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‎3.4 Run Menu 

3.4. RUN MENU 

The Run menu contains SCORBASE commands for homing the robot and peripheral axes (see section ‎4 
Homing and Control page 23), and executing programs. 

The Run Menu is shown here: 

 

Note: If the software is operating Off-Line, only the Run program options are available in this menu. 

This table summarizes the Run Menu options.  

Run Menu Options 

Icon Option (Shortcut) Description 

 

Search home - 
all axes 

Homes both the robot and any configured peripheral axes 

 Search home – robot 

Homes the robot 

This command is available only if the system has been homed once, 
after opening SCORBASE.  

 Search home – peripherals  

Homes the peripheral 

This command is available only if the system has been homed once, 
after opening SCORBASE.  

 Go home – all axes Sends the robot and peripherals to their home positions 

 Go home - robot 
Sends the robot to its home position. This command does not home 
the robot. 

 Go home – peripherals 
Sends the peripherals to their home position. This command does 
not home the peripherals.  

 
Run single line (F6) 

Executes the selected (highlighted) program line. See ‎8 Program 
Execution on page 79 for more information.  
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‎3.5 Options Menu 

 
Run single cycle (F7) 

Executes the program from the selected (highlighted) program line 
to the end of the program 

 
Run continuously (F8) 

Executes the program from the selected (highlighted) program line. 
When the last program line is reached, the program starts again 
from the first line.  

 
Stop (F9) Immediately stops program execution and movement of all axes 

 
Pause (F10) Stops program execution after the current line is executed 

Note: Pause and Stop are software methods for halting program execution. In an actual emergency situation, 
you should use the EMERGENCY button on the controller or the ABORT key on the Teach Pendant. 

3.5. OPTIONS MENU 

The Options menu allows you to define your preferences for operating the software.  

 

The features of the Options menu are summarized in this table: 

Options Menu  

Icon 
Option 
(Shortcut) 

Description 

 

On-Line Establishes communication with the controller 

Off-Line 
SCORBASE does not communicate with the controller, even though it may be connected.  

Off-Line mode is useful for checking and debugging programs.  

 

Control On 
(F5) 

Enables servo control of the axes 

 
Control Off Disables servo control of the axes 
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‎3.5 Options Menu 

Options Menu  

Icon 
Option 
(Shortcut) 

Description 

 Hardware 
Setup 

Opens the Hardware Setup dialog box where you can define the peripheral devices which 
are connected and operated by the controller as axes 7 and 8 

 Set 
Parameters 

Opens the Parameter Set Window Advanced Commands must be activated in order to 
utilize Set Parameters. 

 

 

Parameters can be set for the robot and for each one of the eight axes. Select the 
appropriate tab and set the desired parameters. 

 Line Number Shows/hides program line numbers in the program window 

 
Reload Last 
Project at 
Startup 

When checked, opens the last project saved when SCORBASE is started 

 
Level 1 

Displays list of commands and options at introductory level. Commands related to Level 
2 and Pro are disabled. See ‎10.2.5 Experience Level on page 96 for more information.  

 
Level 2 

Displays list of commands and options at advanced level. Commands related to Pro are 
disabled.  

 
Pro Displays list of all commands and options 
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‎3.6 View Menu 

Options Menu  

Icon 
Option 
(Shortcut) 

Description 

 
Advanced 
Options 

Opens a dialog box in which these options are available: 

 Advanced Commands  

 ViewFlex Commands (see the ViewFlex User Manual) 

 

When one or both options are checked, the corresponding commands (Advanced 
Commands and Vision Commands) are listed under the Command tab of the Workspace 
Window. Parameters should only be modified by skilled operators. 

3.6. VIEW MENU  

The options in the View menu allow you to show/hide SCORBASE dialog bars and windows. 
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‎3.6 View Menu 

The View Menu options are described in this table: 

View Menu Options 

Option Description 

Workspace 
Shows/hides the Workspace Window. Through this window, the user can access the project 
files and the SCORBASE commands tree. 

Manual Movement 
Shows/hides the Manual Movement Dialog Box. This box enables manual control over the 
movements of the robot, the gripper and peripheral axes. 

Teach Positions 

Shows/hides the Teach Positions Dialog Box. This box enables recording, teaching and 
deleting positions. It also enables the user to send the robot and/or peripherals to a 
previously defined position. The functions available depend on the current Experience Level 
setting. 

Robot Movements 
Opens the Robot Movement Dialog Box. Pressing on a selected axis moves it in the selected 
direction. 

Positions 
The Positions Window displays the positions of the currently open project. The list is 
presented in tabular format. 

Charts Opens Charts 

Dialog Bars 

Toggles the display of seven dialog bars that enable the following: 

 Joints – Displays the robot’s joints angle (five joints). 

 XYZ - Displays the robot tool center point (TCP) position and orientation. The 
coordinate system origin is at the center of the robot base at table level. 

 Digital outputs - Displays the status of digital outputs 1-8 (dark green - off; light 
green - on). Click an output to show/hide its status. 

 Digital inputs - Displays the status of digital inputs 1-8 (dark green - off; light green - 
on). In Off-Line clicking on input toggles its status. 

 Analog outputs - Displays the value of analog output 1&2 (0-255)-(0-10 volt). 

 Analog inputs - Displays the value of analog input 1-4 (0-255). In Off-Line you may 
set the analog input value. 

 Encoders – Displays the encoder counts of axes 1-8. (Encoders are zeroed after 
homing the system.) 

Show All Dialog 
Bars 

Displays all seven dialog bars 

Close All Dialog 
Bars 

Closes all seven dialog bars 

Movement 
Information 

Displays the following data: 

 Position error of eight axes in encoder counts 

 Home switch status of all eight axes 

PWM for one selected axis. The PWM (Pulse Width Modulation) is the controller output for 
the selected axis motor 
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‎3.7 Window Menu 

View Menu Options 

Option Description 

Messages 

Opens the Messages Window 

The data displayed in the Messages window is printed using the PS (Print to Screen & Log) 
commanding SCORBASE. 

Toolbar Shows/hides the programming toolbar (default on) 

Status Bar Shows/hides the lower status bar (default on) 

3.7. WINDOW MENU 

The Window menu enables you to select the desired window layout options. 

 

The Window Menu options are described in this table.  

Window Menu Options 

Option Description 

Simulation & Teach 
Sets the screen to display the RoboCell window and the dialog bars required to 
define positions. This is disabled in SCORBASE.  

Teach & Edit 
Opens the Program Window, Workspace Window, Manual Movement Window 
and Teach Position Window. 

Run Screen Displays the Program Window and its toolbar 

Project Screen Displays the Program Window and Positions Window 

Open CIM Screen 
Displays the Program Window, Open CIM Device Driver Window, and CIM 
Messages Window 

User Screen 
This allows the user to customize the screen layout according to personal 
preference 

Save User Screen 
This saves the User Screen layout, allowing it to be recalled with the User Screen 
command 

[Project Name] Displays the file name of the open project 
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‎3.8 Help Menu 

3.8. HELP MENU 

The Help menu is shown here: 

 

This table describes the Help menu options.  

Help Menu Options 

Option Description 

SCORBASE Help (F1)  Opens SCORBASE On-Line help 

Scripting Help Opens help files for Visual Basic scripting 

About Shows the SCORBASE software version 

3.9. CHARTS 

SCORBASE charts can be configured to display the following data (Y-axis) vs. time (X-axis): 

 Encoder counts (axis position), represent the actual axis position. The encoder counts are shown 
as a blue line. 

 Position error is the difference between the required axis position and the actual axis position. 
The error is expressed in encoder counts and is shown as a red line. 

 The PWM value represents the controller output. The error and the axis control parameters 
determine the PWM value which is shown as a green line. 

The data for each axis (1-8) is shown in a different chart. Sample charts for axes 1 and 2 are shown here. 
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‎3.9 Charts 

To open the Charts window, perform one of the following: 

 Click the Charts  icon in the toolbar. 

 Select View | Charts. 

The following options are available in the Charts window toolbar: 

Charts Window Options 

Icon Option Description 

 
Start chart Starts drawing the chart 

 
Stop chart Stops drawing the chart 

 
Options 

Opens the Chart Options dialog box where you can select the data to be displayed in 
the chart(s) 

Click the data that you want displayed in the charts.  

The example shown below results in the display of the Encoder, Error and PWM of 
axis 1, as well as the display of the Encoder and Error for axes 2 through 6. Since each 
axis is shown in a different chart, six charts are displayed. 

 

Any chart can be saved to a history (*.his) file. To do so: 
1. Select the Record History checkbox. 
2. Click the Browse button (which becomes available). This window is displayed: 
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‎3.9 Charts 

Charts Window Options 

Icon Option Description 

  

3. Browse to the location in which the history files are saved, select a file to 
overwrite and click Open. 

4. The filename can be changed in the Chart Options dialog box so that it does not 
overwrite an existing file. 

To set the resolution of the chart for the Encoder, Errors and PWM: 
 Click the Advanced button in the Chart Options dialog box. The Range column is 

displayed. 
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‎3.9 Charts 

Charts Window Options 

Icon Option Description 

 
History 

Opens the History Files Window. Select the desired history (*.his) file from the list or 
browse to locate it.  

 

Note: To open a history file you must first stop drawing the chart. 

 
Legend 

Displays the colors used in the charts for Encoders, Error and PWM. 

Encoders – Blue 
Error – Red 
PWM – Green 
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‎4.1 General 

4. Homing and Control 

4.1. GENERAL 

The robot and peripheral axes location is monitored and controlled using encoders. To initialize the 
encoders and to obtain consistent performance, the axes must first reach a predefined position known as 
hard home. All recorded positions and movements refer to the hard home position. The homing 
procedure finds the hard home for the selected axes. 

SCORBASE offers two commands relating to the home position. 

 Search Home is the procedure for homing. During Search Home, each axis is homed separately. 
The controller activates the currently homed motor axis, until its micro-switch is pressed. Then 
the controller initializes the axis encoder counter and turns to home the next axis. After all 
configured axes are homed, the homing procedure ends. 

 Go Home sends the selected axes to a position where the values of all encoders are zero.  

Note: This command does not home the axes. 

The two commands are available in three levels: 

 Search / Go home all (applies for all active axes) 

 Search / Go home robot (applies for the robot) 

 Search / Go home peripherals (applies for axes 7 & 8). 
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‎4.2 Homing 

4.2. HOMING 

This section covers the homing functions of the robot in SCORBASE.  

4.2.1. Search Home All Axes Command 

To start the homing procedure, do one of the following: 

 Select Run | Search home - all axes. 

 Click the Search Home  icon. 

A window opens displaying the number of the axis currently being homed. Each time an axis is 
successfully homed, a checkmark is displayed next to the axis number. After the five axes and the gripper 
have been homed, a checkmark is displayed next to Robot. 

 

To abort homing while the procedure is still in progress, perform one of the following: 

 Press [F9] (Stop command)  

 Press the red EMERGENCY button on the controller. 

 Press the EMERGENCY key on the Teach Pendant. 

If the homing procedure fails, a message is displayed. 

The Search Home - All Axes command executes the robot’s homing procedure as well as that of any 
peripheral devices that have been configured in the Options | Peripherals Setup menu. This command 
can only be performed when SCORBASE is On-Line. 

If the system has already been homed, and you change SCORBASE to Off-Line mode, there is no need to 
home the system again when you return to On-Line mode. 

When SCORBASE is in Off-Line Mode, or when RoboCell is installed and is in Simulation Mode, the homing 
procedure is not required. The homing procedure initializes Joint and XYZ values according to a software 
definition. All encoders are set to 0, while the robot Cartesian coordinates are set according to a software 
model. 
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‎4.3 Go Home Command 

4.2.2. Search Home – Robot Command 

This command runs the homing procedure for the robot. Homing of the peripherals is enabled only after 
the system has been homed once. 

4.2.3. Search Home – Peripherals Command 

This command runs the homing procedure for the configured peripherals. Homing of the robot is enabled 
only after the system has been homed once. 

4.3. GO HOME COMMAND 

After the axes have been homed, select Run | Go Home - All Axes to send the axes back to their home 
position at any time. This command sends the robot and peripherals to a position where the axes 
encoders value equals zero. The Go Home command does not run the homing procedure. 

Selecting the Go Home - Robot or Go Home - Peripherals command sends the selected axis to its home 
position. 

4.4. ON-LINE MODE / OFF-LINE MODE 

SCORBASE can run either in On-Line or in Off-Line mode. In On-Line mode, SCORBASE communicates with 
the controller over the USB channel. If the Control On state is selected, SCORBASE controls the robot, 
peripherals and I/O device. In Off-Line mode, SCORBASE can be used only in the Control Off state (useful 
for programming and debugging). The active mode is displayed in the status bar. 

To change to On-Line, select Options | On-Line. 

To change to Off-Line, select Options | Off-Line. 

If SCORBASE is opened in On-Line, or On-Line is selected from the Options menu, this message is 
displayed as SCORBASE searches for the controller: 

 

If the controller is detected, On-Line mode is activated. 

If the controller is not detected, Off-Line remains the active mode. 

4.5. CONTROL ON / CONTROL OFF – CON/COFF 

The Control On state enables servo control of the axes. This state is available only in On-Line mode. In the 
Control Off state, axis movement commands cannot be executed. The Control state (On or Off) is 
displayed in the lower right corner of the status bar. 

To enable control of the axes, do one of the following: 

 Select Options | Control On. 

 Click the Control On  icon. 
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‎4.5 Control On / Control Off – CON/COFF 

 Press the F5 key. 

To disable control, do one of the following: 

 Select Options | Control Off. 

 Click the Control Off  icon. 

If you have disabled control and SCORBASE opens in On-Line mode, or On-Line mode is selected after 
detection of the controller, this prompt is displayed: 

 

Press OK to enable control, or press Cancel to remain in the Control Off state. 

The controller automatically disables control if an impact condition, trajectory error, or thermic overload 
error occurs during execution of a movement command. If you attempt to move the axes when control is 
disabled, this error message is displayed: 

 

When SCORBASE is in Off-Line mode, the Control state cannot be altered.
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‎5.1 Joint and Cartesian Coordinate Systems 

5. Position Definition 
Every SCORBASE project includes a set of pre-defined positions and a program that sends the robot from 
one position to the other. Prior to running a program all the positions used in that program should be 
defined. SCORBASE offers various tools to define and store positions that are used in the programs.  

The following SCORBASE tools are used in the position definition process. 

 Manual Movement Dialog Box 

 Teach Positions Dialog Box 

 Robot Movement Dialog Box 

 Position Data Dialog Bars 

 Positions Window 

To activate the dialog boxes which are most useful for position definition, select Window | Teach & Edit. 

Any of the following four methods can be used for position definition:  

Methods for Position Definition 

No. Method Level 

1 Absolute position Joint coordinates 1, 2, Pro 

2 Relative position Joint coordinates 2, Pro 

3 Absolute position Cartesian coordinates 2, Pro 

4 Relative position Cartesian coordinates 2, Pro 

 

Note: Peripheral position definition can only be performed in the Pro level.  

5.1. JOINT AND CARTESIAN COORDINATE SYSTEMS 

Defining a position in SCORBASE can be done by using either the Joint or Cartesian coordinate systems. In 
both systems, a robot position is defined using five parameters derived from the data supplied by the five 
axes encoders. An encoder is an angular movement sensor attached to the axes motor. 

A Peripheral position is always defined using one variable that stores the sensor output (encoder value) of 
that position.  
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‎5.1 Joint and Cartesian Coordinate Systems 

5.1.1. Joint Coordinate System 

A robot position in Joint coordinates is defined by five angle values, representing each angle of the joints. 
The joint names are Base, Shoulder, Elbow, Pitch, and Roll.  

 

For example, after homing, the robot position in Joints coordinates is: 

Axis #1 - Base = (0) 

Axis #2 - Shoulder = (–120) 

Axis #3 - Elbow = (95) 

Axis #4 - Pitch = (88) 

Axis #5 - Roll = (0) 

5.1.2. Cartesian Coordinate System (XYZ) 

A robot position in Cartesian (or XYZ) coordinates is defined by these parameters.  

 The distance of the robot’s Tool Center Point (TCP) from the point of origin (the center bottom of 
the robot base), along the three axes that describe three-dimensional space (X,Y,Z) 

 The Pitch (P) and Roll (R) angles of the gripper, specified in angular units 
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‎5.2 Absolute and Relative Positions 

 

For example, after homing, the robot position in Cartesian coordinates is defined as: 

X = (169) [mm] 

Y = (0) [mm] 

Z = (503) [mm] 

Pitch = (-63) 

Roll = (0) 

A position recorded in one coordinate system can be converted by SCORBASE to another coordinate 
system. 

5.2. ABSOLUTE AND RELATIVE POSITIONS 

SCORBASE offers two methods of defining a robot or peripheral position: absolute and relative. The two 
methods are applicable in Cartesian and in Joint coordinates.  

An absolute position is defined using all five robot position parameters. If the Joint coordinate system is 
used, the robot position is defined using the Base, Shoulder, Elbow, Pitch, and Roll angles. In the XYZ 
coordinate system, a position is defined using the X, Y, Z values in millimeters, and the Pitch and Roll 
angles in degrees. An absolute position is usually a fixed position in world space. 
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‎5.3 Record and Teach 

A relative position is a position whose coordinates are defined as an offset from reference position 
coordinates. If the coordinates of the reference position change, the relative position moves along with it, 
maintaining the same offset. A relative position can be defined in either Cartesian or Joint coordinate 
values. 

A position can also be defined as relative to current. In this case, the relative position is calculated as an 
offset from the coordinates of the current robot position. 

5.3. RECORD AND TEACH 

Although the terms teach and record are often used interchangeably, SCORBASE makes the following 
distinction: 

Record position: defines a robot position in a Joint coordinates system.  

Teach position: defines a robot position in a Cartesian coordinates system. 

5.4. MANUAL MOVEMENT DIALOG BOX 

Recording a robot position (in Joint coordinates) is done by manipulating the robot to the required 
position and then recording it. The Manual Movement dialog box allows direct control and manipulation 
of the robot and peripheral axes. 

The Manual Movement dialog box is automatically opened when a project is opened, or when the 
Window | Teach & Edit display setting is selected. 

To display the Manual Movement dialog box when there are no open projects, select View | Manual 
Movement. This dialogue box is displayed: 

 
 

Note: Axis 6 is not applicable for SCORBOT-ER 2u. Axes 7 and 8 are only applicable when defined using the 
Options | Hardware Setup dialog box. 

The following chart explains how clicking the buttons in the Manual Movement dialog box (or pressing the 
corresponding keys on the keyboard) controls the robot and peripheral movements. 

When Joints is selected, clicking the buttons (or pressing the corresponding keys on the keyboard) moves 
one robot axis at a time, as described below: 

Joints 

Keys Joint Motion 

1 / Q Rotates the BASE right and left 

2 / W Moves the SHOULDER up and down 

3 / E Moves the ELBOW up and down 

4 / R Moves the wrist (PITCH) up and down 
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‎5.4 Manual Movement Dialog Box 

5 / T Rotates the wrist (ROLL) right and left 

6 / Y Opens and closes gripper via servo control 

7 / U Moves peripheral axis #7 (if connected) 

8 / I Moves peripheral axis #8 (if connected) 

 

When XYZ is selected as shown here, clicking the buttons (or pressing the corresponding keys on the 
keyboard) moves the TCP, as described below. 

 

Movements in XYZ mode are sometimes a combination of simultaneous movements of a few axes. 

XYZ 

Keys XYZ Motion 

1 / Q TCP moves along X-axis (back and forth) 

2 / W TCP moves along Y-axis (right and left) 

3 / E TCP moves along Z-axis (up and down) 

4 / R Axes move in order to change the gripper’s pitch angle; the TCP position does not change 

5 / T The gripper rolls; the TCP position does not change 

The Gripper options are described in this table: 

Gripper Options 

Icon Option Description 

  
Open Gripper Completely opens the gripper 

 
Close Gripper Completely closes the gripper 

The robot can be manipulated from the Manual Movement dialog box before it has been homed in Joint 
mode only. In fact, it is often necessary to bring the robot into a more suitable position before initiating 
the homing routine. However, an axis limit error message may be displayed during manipulation of a 
robot that has not been homed. 
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‎5.5 Robot Movement Dialog Box 

Movement of an axis continues as long as the button or key is pressed, or until a software or hardware 
limit is reached. 

5.5. ROBOT MOVEMENT DIALOG BOX 

The Robot Movement dialog box, shown here, enables control over the robot in XYZ and Joint modes. 

 

Clicking on an axis image or the XYZPR buttons moves the robot as described above in the Manual 
Movement Dialog Box section. 

To open the Robot Movement dialog box, select View | Robot Movement. 

5.6. TEACH POSITIONS DIALOG BOX 

The Simple/Expanded Teach Positions dialog box enables the following: 

 Teaching positions (in Cartesian coordinates). 

 Recording positions (in Joint coordinates). 

 Sending the axes to the recorded positions (when program is not running). 

 Go to Position 

 Go Linear 

 Go Circular 

To display the description of the function of each icon in the Teach Position dialog box, simply place the 
mouse on the desired icon without clicking a mouse button.  

The user can define 1,000 positions. A higher computer (CPU and memory) can hold more positions.  

5.6.1. Simple (Level 1) 

The Teach Positions (Simple) dialog box is shown here: 
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‎5.6 Teach Positions Dialog Box 

 

The Teach Positions (Simple) dialog box offers the following options: 

Simple Dialog Box 

Option Level Description 

Position Number 1, 2 & Pro A numerical name for position 

 

Record 

1, 2 & Pro 
Records the current robot position (in joint coordinates) to the position 
displayed in the position number field 

 

Delete  

1, 2 & Pro Deletes from memory the position in the position number field 

 

Go to Position 

1, 2 & Pro 
Executes the Go to Position command, which sends the robot’s TCP 
(Tool Center Point) from its current position to the selected position 

Speed 1, 2 & Pro 
Selects the speed for all movement commands. 10 fastest, 1 slowest, 5 
default 

5.6.2. Simple (Advanced Level) 

The Advanced (Level 2) Teach Positions dialog box is shown here: 

 

At the Advanced level, the Teach Positions dialog box offers all the commands available at Level 1, and 
also all of the following: 

Advanced Teach Positions Dialog Box 

Option Level Description 

Expand 2 & Pro Opens the Teach Positions (Expanded/Simple) dialog box 
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‎5.6 Teach Positions Dialog Box 

Absolute / 
Relative to 

2 & Pro Defines positions either as absolute or relative to another position. 

When Relative to is selected, a Relative to field is displayed. Select either 
an existing position or Current. A position that is Relative to Current means 
that the reference position is the robot position at the time it is sent to 
that position. 

Relative to is only available to Level 2 and Pro. 

5.6.3. Expand (Advanced and Pro Levels) 

Click Expand to open the Teach Positions (Expanded) dialog box: 

 

 

Teach Positions (Expand) Dialog Box for Level 2 (Advanced) User 

Option Description 

X(mm), Y(mm) 
Z(mm), 
Pitch(deg), 
Roll(deg) 

Fields for displaying or changing the Cartesian coordinates of the selected position 

Get Position Displays the Cartesian coordinates of the selected position 

Clear Clears all position coordinate fields. The position data does not change.  

Teach Teaches position using the Cartesian Coordinate System 

 

Go Circular 

Executes the Go Circular to Position command. This command sends the robot in a circular path 
to the target position (in the position number field), via the position specified in the Via position 
field. 

The circular motion applies only to the robot. 

 

 
Via position Selects the intermediate position through which the Go Circular movement passes 
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‎5.7 Recording Positions (Joint Coordinates) 

 

Go Linear to  
Position 

Executes the Go Linear to Position command. Sends the axes in a straight line to the selected 
position 

 

 

 

 

Simple Toggles to the Teach Position (Simple) dialog box 

5.6.4. Simple (Pro Level) 

The Teach Positions (Simple) Dialog Box (Pro Level) is shown here: 

 

At the Pro level, the Simple Teach Positions dialog box offers the following additional commands: 

Teach Positions (Simple) Dialog Box (Pro Level) 

Option Level Description 

Include Axes Pro 

Instructs the controller to define coordinates for axes for 
Robot, Peripheral or both 

A peripheral position can be recorded only in the Pro level. 

Duration Pro 

Defines the time it takes to complete a movement 
command. The time is defined in tenths of a second. For 
more information, see section ‎6.4 Axis Control Commands  
on page 45. 

These commands remain available when the Teach Positions dialog box is expanded. 

5.7. RECORDING POSITIONS (JOINT COORDINATES) 

This section covers the procedures involved in recording positions in SCORBASE.  

5.7.1. Record Absolute Position (Levels 1, 2 & Pro) 

To record an absolute position: 

1. Use either the Manual Movement dialog box or the Robot Movement dialog box to move the 

robot to the position you want to record. 

2. Click the Teach Position dialog box. 

3. Type a position number in the Position Number field, or select an existing position number if you 

want to modify (overwrite) a previously defined position. 

4. Select Absolute. 
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‎5.8 Teaching Positions (XYZ Coordinates) 

5. Select Include Axes (Robot and/or Peripherals): 

a. Robot: to record a position for the robot axes. 

b. Peripherals: to record a position for the peripheral axes (Pro level only). 

6. To record the current position, click the Record Position icon.  

5.7.2. Record Relative Position (Pro Level) 

To record a relative position: 

1. Make sure you have first defined a reference position.  

2. Move the robot to the position whose coordinates you want to record as relative to another 

position. 

3. In the Position Number field in the Teach Positions (Simple) dialog box, enter a new position 

number. 

4. Select Relative to.  

5. Enter a number (or select Current) for the reference position in the Relative to field. 

6. Click Record. You have now recorded a relative position. 

A position that is Relative to Current means the specified offset is computed from the location at which 
the robot is positioned at the time it is sent to the relative position. If the reference position changes, the 
relative position also moves. 

5.8. TEACHING POSITIONS (XYZ COORDINATES) 

In order to teach a position in XYZ coordinates, click Expand.  

5.8.1. Teach Absolute XYZ Position (Levels 2 & Pro) 

To teach an absolute XYZ position: 

1. Click Expand. 

2. Enter XYZ, Pitch and Roll values. 

3. Click Teach. 

To use existing position coordinates to define a new position (or modify that position’s coordinates), 
perform this procedure: 

1. In the Position Number field in the Teach Positions dialog box, select an absolute position number. 

2. Click Get Position. The XYZPR values of the position now are displayed in the XYZ, Pitch and Roll 

fields. Note: If the position is relative, only the offset values are displayed. 

3. In the Position Number field, enter a different number (or leave the position number if you want 

to modify that position). 
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‎5.9 Positions Window 

4. To record a position for the robot axes, click Robot. 

To record a position for the peripheral axes, click Peripherals. 

To record positions for both, click Robot and Peripherals. 

5. In one or more of the coordinate fields, enter a new value (in millimeters or degrees). 

6. Click Teach. 

Note: If you click Record, the current TCP coordinates are written to the selected position. 

5.8.2. Teach Relative XYZ Position (Levels 2 & Pro) 

To teach a relative XYZ position: 

Make sure you have first recorded the reference position.  

1. In the Position Number field, in the Teach Positions dialog box, enter the new position number. 

2. Select Relative to, and enter the number of the reference position in the Relative to field. All XYZ 

coordinate fields are blank or show 0. 

3. In one or more of the coordinate fields, enter a new value (in millimeters or degrees). 

4. Click Teach. 

A position that is relative to current means the specified offset are computed from wherever the robot is 
located at the time it is sent to the relative position. 

If the reference position changes, the relative position moves accordingly. 

5.9. POSITIONS WINDOW 

This section covers the SCORBASE Positions Window.  

5.9.1. Overview 

The Positions window displays a list of the positions of the currently open project. The list is presented in 
tabular format. As default, the table presents position information in both the Joint Coordinate System 
and the Cartesian Coordinate System. 

When fully open, the window is divided horizontally into two panels. By dragging the bottom edge of the 
window, you can reveal the bottom panel. The top panel displays all positions in the project (Position 
Inventory Panel). The bottom panel (Watch Panel) displays the positions which have been selected for 
watching. 

Shown below, the Positions Window is fully opened to display both the Position Inventory Panel and the 
Watch Panel. 
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‎5.9 Positions Window 

 

Each row in the top portion of the table represents a single position. To manipulate the list: 

 Select a position (row). 

 Right-click to display the popup window. 

5.9.2. Position Popup Window 

The Position popup window is shown here.  

 

The Position Popup Menu options are summarized in this table: 

Position Popup Menu Options 

Option Description 

Position No. Displays the number of the position 

Delete Deletes the selected position 

Delete All Deletes all listed positions from the Position Inventory Panel and the SCORBASE 
memory 

Add Watch Copies the position data to the watch list, visible in the Watch Panel 

Show Joint Shows only Joint values of all positions 

Show XYZ Shows only the XYZPR of all positions 

Show Both Shows both Joint and XYZPR values of all positions 

 
Note: The peripheral positions are always displayed using encoder counts. 
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‎5.10 Position Data Dialog Bars 

5.9.3. Watch Popup Window 

The Watch popup window is shown here:  

 

The Watch Popup window options are described here:  

Watch Popup Window Options 

Option Description 

Position No. Displays the number of the position. 

Delete Removes the selected position from the watch list, but does not affect its presence in 
the overall list 

Delete All Removes all listed positions from the watch list, but does not affect their presence in 
the overall list 

Show Joint Shows only Joint values of all positions. This can be set to a value different from the 
Position Inventory Panel.  

Show XYZ Shows only the XYZPR of all positions. This can be set to a value different from the 
Position Inventory Panel.  

Show Both Shows both Joint and XYZPR values of all positions 

5.10. POSITION DATA DIALOG BARS 

SCORBASE offers three dialog bars that display all axes, encoder counts and the robot position in 
reference to both the Cartesian Coordinate System (XYZ) and the Joint Coordinate System. All dialog bars 
are accessible at all levels via the View menu. They may also be opened or closed using the View | Show 
All Dialog Bars or View | Close All Dialog Bars commands. 

5.10.1. Encoder Counts Dialog Bar 

The Encoder Counts dialog bar, shown here, displays the current values of the encoders for each of the 
eight axes.  

 

To display the Encoder Counts dialog bar, select View | Dialog Bar | Encoders. 

The encoder values change whenever the axes are moved. 

These values are set to 0 (or close to zero) after the Search Home All Axes command is executed. 



 

‎5 Position Definition 40 

‎5.11 Using a Teach Pendant with SCORBASE 

5.10.2. XYZ Dialog Bar 

The XYZ dialog bar displays the current Cartesian Coordinate System (XYZ PR) values of the TCP. 

 

To display the XYZ dialog bar, select View | Dialog Bar | XYZ.  

The values shown in the above example are the Joint values after the Search Home command is executed. 

5.10.3. Joints Dialog Bar 

The Joints dialog bar displays the angles between the two links of the joint, in degrees. 

 

To display the Dialog bar, select View | Dialog Bar | Joints. 

The values shown in the above example are the XYZ values after the Search Home command is executed. 

5.11. USING A TEACH PENDANT WITH SCORBASE 

The Teach Pendant is a hand-held terminal that gives the operator direct control of the robot and 
peripheral axes. In addition to controlling movement of the axes, the Teach Pendant may be used for 
recording positions, sending the axes to recorded positions, and other functions. 

To control the axes from the Teach Pendant, SCORBASE must be operating in the On-Line mode, and the 
Teach/Manual switch on the Teach Pendant must be switched to Teach. This disables control of the axes 
from SCORBASE dialog boxes. 

All Teach Pendant operations are reflected in the SCORBASE dialog boxes. For example, positions 
recorded by the Teach Pendant are displayed in the Position Number list in the Teach Positions dialog 
box; and encoder and XYZ values change in the Encoder Counts and XYZ dialog boxes. 

The Teach Pendant operation is described fully in the Teach Pendant for Controller User Manual. 
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‎6.1 Opening and Closing a Program 

6. Program Editing 
A SCORBASE program is a set of instructions written by the user to control the robot, peripheral 
equipment and to communicate with external I/O devices. This chapter explains how to create and edit a 
SCORBASE program. 

The following tools are used for program editing: 

 Program commands editor 

 Command tree that lists all SCORBASE commands 

6.1. OPENING AND CLOSING A PROGRAM  

Every SCORBASE program is part of a SCORBASE project. A project also includes the user-defined 
positions, project data and, if RoboCell is installed, a virtual cell (3dc file). Only one project can be opened 
at a time. 

To open a saved program, open the project containing the desired program by performing one of the 
following: 

 Select File | Open Project…  

 Click the Open an Existing Project  icon.  

 Press Ctrl + O. 

In all cases, the Load Project window opens, prompting you to select the project that contains the 
program you want to edit.  

The program is displayed in the Program Window. 

To create a new project, perform one of the following: 

 Select File | New Project…  

 Click the Create a New Project  icon.  

 Press Ctrl + N. 

By default, the new project is opened with the Teach & Edit layout. This layout displays four windows: 

 Program Window that holds the SCORBASE program 

 Manual Movement Dialog Box 

 Teach Positions Dialog Box 

 Workspace Window that shows: 

 Project data, i.e., positions, user program and graphical display (if installed) 

 SCORBASE Command Tree 
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‎6.2 Program Editing Tools 

The Program Window, shown below, contains the text of the SCORBASE program currently loaded. Its title 
bar displays the name of the project. Also shown by default is the programming toolbar. The toolbar 
contains a drop-down list of all subroutines available, for quick navigation.  

 

The Workspace Window contains two tabs to switch between the project files and the commands 
currently available. The Project tab is shown here: 

 

The Commands tab displays the Command Tree, which in turn displays all of the commands available for 
the currently set Experience Level. 

6.2. PROGRAM EDITING TOOLS 

SCORBASE is a text-based programming language in which every command is a single text line. SCORBASE 
programs are edited by means of the standard Windows text editing options, which can be accessed: 

 Via the Edit menu. 

 By pressing the designated keys. 

 By right-clicking the mouse in the Program Window to open a pop-up menu. 
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‎6.2 Program Editing Tools 

Program Editing Tools 

Option - Shortcut Description 

Cut - Ctrl+X Deletes selected text or lines from the program, and places it on the Windows 
and SCORBASE clipboards 

Copy - Ctrl+C Places a copy of selected text or lines from the program on the Windows and 
SCORBASE clipboard 

Paste - Ctrl+V Inserts the contents of the SCORBASE clipboard into the program 

Find - Ctrl+F Opens a dialog box (shown here) that allows you to search for any string, such as 
a command or text 

 

Find Next - (F3) Repeats the last Find operation for the next occurrence. (Accessible also from the 
Find dialog window) 

Command/ 
Remark (*…) 

Inserts/deletes asterisk at beginning of a command line 

SCORBASE ignores command lines that start with an asterisk. This feature is useful 
for debugging. 

Go to Line Opens a dialog box (shown here) that displays the total number of lines in the 
program and prompts you for a line number. Type in the number. The program 
editor jumps to the line you specify. 

 

Go to Selected Line Automatically scrolls the Program Window to display the line which you have 
selected. This is useful for long programs when you have selected a particular line 
and then scrolled away from it. In very short programs which fit within a single 
window, this function has no visible effect. 

 

In addition, use the keyboard for the following functions: 
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‎6.3 Adding and Editing Commands 

Additional Program Editing Functions 

Keyboard Shortcut Function 

[Ins] 

Toggles between Insert Mode and Overwrite Mode. The currently active mode is 
shown in the Status bar at the very bottom of the SCORBASE window. 

In Insert Mode, a new command is inserted into the program above the line currently 
marked by the cursor. 

[Del] Deletes the line or lines currently marked by the cursor 

[Ctrl+Home] Brings the cursor to the first line of the program 

[Ctrl+End] Brings the cursor to the last line of the program 

[PgUp] Displays the previous page of program lines 

[PgDn] Displays the next page of program lines 

6.3. ADDING AND EDITING COMMANDS  

SCORBASE commands are organized in a Command Tree, which is displayed in the Workspace Window. 
SCORBASE only displays the commands which are available in the currently set Experience Level.  

 At the Introductory level (Level 1), only basic commands are displayed in the Command Tree. 

 At the Advanced level (Level 2), the number of commands is increased. 

 At the Professional level (Pro Level), all commands are accessible. 

To see the Command Tree, click the Command tab in the Workspace Window.  

SCORBASE commands are grouped into these categories: 

 Axis & Control 

 Program Flow 

 Inputs & Outputs 

 Advanced - By default, this category is hidden. Select Options | Advanced Options | Advanced 
Commands to display these commands.  

 Vision - By default, this category is hidden. Select Options | Advanced Options | ViewFlex 
Commands to display these commands.  

Clicking on a category opens/closes the list of commands. 

To add commands to a program, perform one of the following: 

 Double-click the desired command in the Command Tree. 

 Type the two letters written next to the command. 

 Click the command icons in the Program Window (applicable only for selected commands).  

If you are working in Insert Mode, the new command line is added above the currently selected 
(highlighted) line. If you are working in Overwrite Mode, the new command replaces the selected line. 
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‎6.4 Axis Control Commands 

Toggle between the two modes using the [Ins] key. Many commands open dialog boxes for completing 
the command line parameters. 

To change a command parameter, click the command to re-open the command dialog box. Change the 
required parameter, and click OK to close the dialog box.  

Note: For safety reasons, certain parameters are not accessible by the user, i.e., they are displayed as 
grayed, and can be changed only by Intelitek support personnel.  

To delete, cut, copy and paste a line, use the standard Windows tools. 

6.4. AXIS CONTROL COMMANDS 

The Axis Control options, commands, and functions are described in the following tables.  

Axis Control Command Tree 

Level 1 – Introductory Level 2 – Advanced Pro – Professional 

 

 

 

 

Axis Control Commands 

Icon Command Levels Description 

 OG Open Gripper 1,2,Pro Fully opens the gripper 

 CG Close Gripper 1,2,Pro Fully closes the gripper (on itself, or on a grasped object) 
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‎6.4 Axis Control Commands 

Axis Control Commands 

Icon Command Levels Description 

 GP Go to Position 1,2,Pro 

Opens the Go to Position dialog box, shown here. The Go to Position 
command sends the robot to a recorded position, in the shortest time, 
using Point to Point (P to P) control. In Point to Point control, all axes 
move independently and there is no control over the TCP trajectory.  

 

 

Movement Control 

Option Description 

Target Position The destination of the movement. Enter a number or a variable in this field.  

 

Speed/Duration Options 

Option Description 

Fast Executes the movement at the fastest speed possible 

Speed 
Executes the movement at a slower speed. Enter a number from 1 through 99(%), or a 
variable, in the Speed field. Default: 50 (average speed). 

Duration 
Executes the movement in a specific amount of time. Enter the time in tenths of a second, 
or a variable. Available only in Pro Level. 

Via Position 
The position via which the destination of the movement is reached. Enter a number or a 
variable in this field.  
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‎6.4 Axis Control Commands 

Additional Movement Control Options 

Icon Option Level Description 

 

GL Go Linear 
to Position 
#_Speed ... 

2,Pro 

Sends the robot’s TCP (tool center point) from its current position to the target 
position, along a linear path (straight line). The linear motion applies only to the 
robot axes. For linear motion, speed can also be defined in mm/s. 

 

 

GC Go 
Circular to 
Position #_ 
Speed... 

2,Pro 

Sends the robot’s TCP in a circular path to the target position, via the position 
specified in the Via Position field. The circular motion applies only to the robot. 

Note: The Circular command follows the circle defined by the three positions 
(current TCP position, target position, and the intermediate position specified in 
the Via position field). 

 Via Position  
The position via which the destination of the movement is reached. Enter a 
number or a variable in this field.  
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‎6.4 Axis Control Commands 

Additional Movement Control Options 

Icon Option Level Description 

 JA Jaw 2,Pro 

Moves the gripper’s jaw to the specified span. The command opens this dialog 
box: 

 

Enter a number or a variable in the Jaw field. 

Note: Accuracy cannot be guaranteed if the width is less than 5 mm or greater 
than 65 mm. 

Jaw activates Servo Control for the gripper motor, whereas Open Gripper and 
Close Gripper commands do not use the gripper axis Servo Control. 

Unless you need the Jaw command for a specific application, the Open Gripper 
and Close Gripper commands are recommended. 

Note: This command is not available for SCORBOT-ER 2u. 

 

IL If Limit 
Switch < # > 
on jump to 
<Label> 

2,Pro 

The IL is a conditional jump command. It causes program execution to jump to the 
line that contains the specified Label, if the selected axis micro switch is pressed 
(On). The command opens this dialog box. 

 

Enter the Axis number or a variable in the Limit Switch field.  

Enter the name of a Label in the Jump to field. 
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‎6.4 Axis Control Commands 

Additional Movement Control Options 

Icon Option Level Description 

 
RP Record 
Position #_ 
 

Pro 

When the Record Position command is executed (during program execution), the 
controller records the current position data to the specified position. The 
command opens this dialog box: 

 

Enter a position number or a variable in the Record Present Position as Position 
field.  

The Record Position command is useful when a position (and all relative positions 
that refer to that position) must be relocated, during program execution. This 
command updates the position data. 

 
SA Set Axis 
#_ ... (to 
Zero) 

2,Pro 

Initializes (sets to 0) the encoder count of the selected axis. The command opens 
this dialog box: 

 

Enter a number or a variable in the Axis field. 
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‎6.4 Axis Control Commands 

Additional Movement Control Options 

Icon Option Level Description 

 
SC Start 
Conveyor 
 

Pro 

Starts the conveyor, as a speed-controlled conveyor. Movement of the conveyor 
continues until a Stop Conveyor (ST) command is encountered. 

The command opens this dialog box: 

 

Note: When operating a speed controlled conveyor by means of the Start/Stop 
Conveyor commands, do not record positions, and/or use the Set Axis (to Zero) 
command for the conveyor, in the same program. 

 
ST Stop 
Conveyor 

Pro 
Stops the continuous motion of a conveyor that was initiated by a Start Conveyor 
(SC) command 

 

SG Set 
Variable to 
Gripper 
Sensor 

Pro 

Assigns the value of the gripper opening (in mm) to a variable. This command is 
useful when there is a need to measure the object in the gripper, or to check the 
gripper status (open, closed or gripping an object). 

 

In the Name field, enter the name of the variable. 

For more information on variables, see section ‎7 Variable Programming on page 
75. 

Note: This command is not available for SCORBOT-ER 2u. 
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‎6.4 Axis Control Commands 

Additional Movement Control Options 

Icon Option Level Description 

 WR Write  

Commands the gripper to convert the letters specified into lettering on the 
workpiece. The size is controlled by the Scale setting (1-10). The Write dialog box 
is shown here.  

 

 
CN 
ControlOn 

 Enables axis control by the controller 

 
CF 
ControlOff 

 Disables axis control by the controller 

 
TJ Teach 
Position By 
Joints 

Pro 

Teaches the position as defined by the absolute positions of the joints. The Teach 
Position (Absolute Joints) Dialog Box is shown here: 

 

   Get Position 
Copies the values of the robot’s current 
position into the appropriate boxes. 

   Clear Clears the values from all the boxes 
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‎6.4 Axis Control Commands 

Additional Movement Control Options 

Icon Option Level Description 

 

RJ Teach 
Position By 
Joints 
Relative to 
Position 

Pro 

Teaches the position as defined by the positions of the joints relative to another 
defined position. The Teach Position (Relative Joints) Dialog Box is shown here: 

 

 
TX Teach 
Position by 
XYZ 

Pro 

Teaches the position as defined by the absolute Cartesian coordinate of the TCP 
(Tool Center Point). 

 

 

RX Teach 
Position by 
XYZ Relative 
to Position 

Pro 

Teaches the position as defined by the Cartesian coordinate of the TCP (Tool 
Center Point) relative to another defined position. 
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‎6.4 Axis Control Commands 

Additional Movement Control Options 

Icon Option Level Description 

 

SJ Set 
Variable to 
Joint 
Position 

 

Allows you to set a variable to the value of a specified joint at a specified position 
number. Set Variable to Joint Position Dialog Box is shown below.  

 

An integer between 1 and 5 is inserted for the Joint number, as follows: 

Base 1 

Shoulder 2 

Elbow 3 

Pitch 4 

Roll 5 

You may also insert a variable which contains one of these values. 
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‎6.4 Axis Control Commands 

Additional Movement Control Options 

Icon Option Level Description 

 

SX Set 
Variable to 
Cartesian 
Position 

 

Allows you to set a variable to the value of a specified Cartesian coordinate at a 
specified position number. The Set Variable to Cartesian Position (Relative XYZ) 
Dialog Box is shown here.  

 

An integer between 1 and 5 is inserted for the Joint number, as follows: 

Base 1 

Shoulder 2 

Elbow 3 

Pitch 4 

Roll 5 

You may also insert a variable which contains one of these values. 
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‎6.5 Program Flow Commands 

6.5. PROGRAM FLOW COMMANDS 

The Program Flow commands are summarized in the tables below.  

Program Flow Branch Command Tree 

Level 1 – Introductory Level 2 – Advanced Pro – Professional 

 

 

 

 

Program Flow Commands 

Icon Command Levels Description 

 
WT Wait 
(10ths of 
second) 

1,2,Pro 

Halts program execution for a time specified in tenths of a second. The command 
opens this dialog box: 

 

 
WC Wait For 
Condition 

2,Pro 
Halts program execution until the defined condition is fulfilled. The command 
opens this dialog box: 
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‎6.5 Program Flow Commands 

Program Flow Commands 

Icon Command Levels Description 

 

 
JU Jump to 
 

1,2,Pro 

This unconditional jump command causes the program pointer to jump to the line 
that contains the specified Label. The command opens this dialog box: 

 

When the Jump command is used, Jump is checked in the dialog box. You can 
modify the Jump command to an IF jump command (conditional jumping) only in 
Levels 2 and Pro. 

 RE Remark 2,Pro 

Allows insertion of a comment line for explanation and documentation into the 
program. The command opens this dialog box: 

 

Up to 47 characters of text may be inserted, including spaces. 

 RB Ring Bell 2,Pro 
When executed, this command produces a beep, using the computer’s internal 
loudspeaker. 

 
RT Reset 
Timer 

Pro 

SCORBASE uses a timer that measures time in units of tenths of a second. The 
timer starts operating when SCORBASE is opened.  

The Reset Timer command resets the value of the SCORBASE timer to 0. 

To use the timer, the timer value must be assigned to a variable, using the Set 



 

‎6 Program Editing 57 

‎6.5 Program Flow Commands 

Program Flow Commands 

Icon Command Levels Description 

Variable command.  

 

SV Set 
Variable to 
Computation 

1,2,Pro 

Allows you to assign a value, or an expression (result of a specific computation), 
to a variable. 

The command opens the Set Variable dialog box (Computation is selected by 
default). 

 

In level 2, the Set Variable value can only be a result of computation. In the Pro 
level, variable values can be derived from other sources. For more information. 

   

Variable Name 

The first character of the variable name must be a letter. 

Value or Expression 

Enter a value or a formula. 

To set the variable to a fixed value, enter a number (in the range of +/-1000000). 

To set the variable to the result of a computation, enter a string that consists of 
two arguments and an operator. An argument can be either an integer or a 
variable (e.g., fun*2). 

Click the arrow to see a list of operators, or use the list of operators, which is 
shown below.  
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‎6.5 Program Flow Commands 

The Operators Drop-Down List is shown here: 

 

The operators in the list are summarized in this table.  

Operators 

Arithmetic Operators 

+ 

* 

- 

/ 

\ 

Addition 

Multiplication 

Subtraction 

Division 

Floating Point Division 

Algebraic Operators 

^ Power (raises the first argument to the power of the second argument). 

MOD Modulus (returns the remainder of the first argument divided by the second). 

Logical (Boolean) Operators 

NOT 

AND 

OR 

XOR 

EQV 

IMP 

Not 

And 

Or 

Exclusive or 

Equivalent (Null or Boolean values only) 

Implication (Null or Boolean values only) 

The result of a logical operation is 1 (True), or 0 (False). Any operand with a non-zero value is considered 
true, while a zero value is considered false. 
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‎6.5 Program Flow Commands 

Set Variable Dialog Box 

Icon  Option Level Description 

   

A value assigned using the SV command can be used for conditional jumping 
using the IF <Condition> Jump command. Actions can then be generated 
according to the variable value. The following example jumps the program 
cursor to a label if more than three seconds elapse after timer reset: 

Reset Timer 
… 
Set Variable TIME to timer 
IF TIME > 30 jump to PICKUP 

For more information on variables, See section ‎7 Variable Programming, on 
page 75. 

 
VT Set 
Variable to 
Timer 

Pro 

Allows you to assign the current value of SCORBASE timer to a variable. 

The SCORBASE timer starts operating when SCORBASE is opened. 

 

To initialize the SCORBASE timer in a program, use the Reset Timer (RT) 
command. 
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‎6.5 Program Flow Commands 

Set Variable Dialog Box 

Icon  Option Level Description 

 
IF If Jump to 2,Pro 

A conditional branch command, which is used to determine the program flow 
in relation to the value of the variables. The command opens this dialog box: 

 

If the condition in the IF field is true, program execution jumps to the line 
specified by the label in the Jump to field. 

If the condition in the IF field is false, program execution skips to the following 
line. 

   

IF 

Enter the condition. The condition includes a variable name, a comparison 
operator and another variable name, or a number. 

Jump to 

Enter the name of a Label. (Be sure to include a line with this Label in your 
program.) 

   

Example: 

If COUNTER > 0 jump to START_LOOP 
Go to Position 1 speed 5 
… 
START_LOOP: 
Go to Position 2 speed 5 

If the value of Counter is greater than zero, the robot goes to Position #1.  

If the value of Counter is equal to or less than zero, the robot goes to Position 
#2. 

Use two equal signs (= =) for equal operators. For example: 

If COUNTER == 0 jump to END 

The IF jump command can be converted to an unconditional jump command 
by selecting Jump (instead of If). 
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‎6.5 Program Flow Commands 

Set Variable Dialog Box 

Icon  Option Level Description 

 
SS Set 
Subroutine 

2,Pro 

Creates a subroutine. You can program up to 64 subroutines in one program. 
The command opens this dialog box: 

 

Note: Create subroutines only at the end of the main program. Every 
subroutine must end with a Return from Subroutine command. 

 
RS Return 
from 
Subroutine 

2,Pro 

Marks the end of a subroutine. At run time, this command terminates the 
execution of the subroutine, and the program resumes execution at the line 
that follows the Call Subroutine command. 

Note: Every subroutine must end with a Return from Subroutine command. 

 
CS Call 
Subroutine 

2,Pro 

Activates the specified subroutine. The command opens this dialog box: 

 

Notes:  

 Use the Call Subroutine command either from the main program or 
from another subroutine command. 

 You can call the same subroutine repeatedly in the same program. 

 You can call a subroutine from a Visual Basic script that is loaded. 
Append the prefix SCRIPT. to the beginning of the Visual Basic 
subroutine name. If more than one VB script is loaded, it is the 
responsibility of the programmer to ensure that there is no conflict of 
names. 

 After the subroutine is executed, the program resumes execution 
from the line that follows the Call Subroutine command. 
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‎6.5 Program Flow Commands 

Set Variable Dialog Box 

Icon  Option Level Description 

 

RU Run 
Subroutine 

Pro 

Activates the selected subroutine. The command opens this dialog box: 

 

Either write a subroutine name, or select one from the drop down menu. To 
include the subroutine in the SCORBASE program, press the Program button. 
To run the subroutine, press the Execute button. 

When the command is initiated, execution of the main program continues, and 
the subroutine runs concurrently. SCORBASE facilitates the operation of up to 
100 concurrent programs. (The Call subroutine command suspends the main 
program until the completion of the subroutine.) 

 LA Label 1,2,Pro 

Marks a line in the program that is referenced by a Jump command. The 
command opens this dialog box: 

 

In the Label field, enter a name.  

Do not include blank spaces – use an underscore. 

Do not use the same label name more than once. 
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‎6.5 Program Flow Commands 

Set Variable Dialog Box 

Icon  Option Level Description 

 
PS Print to 
Screen & 
Log 

2,Pro 

Instructs SCORBASE to print data containing strings, messages and variable 
values to a log file, or to the message window, or to both. The command opens 
this dialog box: 

 

To print a value of a variable, place the variable name in single quote marks. 
For example: VARX='X' prints as VARX=50 (when the value of X is 50).  

To print a value of a Visual Basic Script variable, include “SCRIPT.” followed by 
the variable name in single quote marks. For example: VARY='SCRIPT.Y' prints 
as VARY=100 (when the value of SCRIPT.Y is 100). Select the desired print 
destination. 



 

‎6 Program Editing 64 

‎6.5 Program Flow Commands 

Set Variable Dialog Box 

Icon  Option Level Description 

 
SM Send 
Message  

Pro 

Sends a message to MANAGER, Robot Device Driver, CNC Device Driver, or 
Device Driver. 

 

For a message to the MANAGER, select the type of message from the list of 
available types. Type a Task ID, and select a message from the drop-down 
menu. Consult the Open CIM user manual for more details. The Send Message 
(Manager) dialog box is shown here.  

 

For other device drivers, type the ID of the device you wish to receive the 
message, and enter the string to be sent. The Send Message (Robot Device 
Driver) dialog box is shown here. 
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‎6.5 Program Flow Commands 

Set Variable Dialog Box 

Icon  Option Level Description 

 
MC Send 
Command 

Pro 

Sends a command to the CNC Device Driver. This is the same dialog box as the 
SM command, except that the default device is the CNC Device Driver, and the 
default message is a command, rather than a string. Send Command (CNC 
Device) Dialog Box is shown here.  

 

Enter the device ID and the command in the boxes. 

 
LS Load 
Script 

Pro 

Loads a Visual Basic script by means of the following dialog box: 

 

The script must be located in the same subdirectory as the SCORBASE project 
file. You must be sure that the LS command is actually executed before you 
attempt to call any of the affected subroutines or variables. 

You may load more than one script into a single SCORBASE project. However, it 
is the programmer’s responsibility to ensure that there are no name conflicts. 

 
EN End 
Program 

Pro 
This command enters the command End on the selected line of the program. It 
signifies the end of the program. It may be used in more than one subroutine, 
such as subroutines which respond to various error conditions. 
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‎6.6 Input/Output Commands 

6.6. INPUT/OUTPUT COMMANDS 

Inputs & Outputs Branch Command Tree 

Level 1 – Introductory Level 2 – Advanced Pro – Professional 

 

 

 

 

Input and Output Command 

Icon Option Level Description 

 

II If Input # 
On/Off Jump 

1,2,Pro 

Causes the program to jump to a label or call a subroutine, if the state of 
the tested digital input matches the status specified (On or Off). The 
command opens this dialog box: 

 

In the Input Number field, enter the number of digital input (1-8), or a 
variable. 
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‎6.6 Input/Output Commands 

 
OI On Input 
Interrupt # 
On/Off 

Pro 

Sets the condition for an input interrupt service. The service (Call 
Subroutine or Run Subroutine) is performed whenever the condition (input 
status) is satisfied, regardless of the current program pointer position. The 
command opens this dialog box: 

 

   

Input Number 

Enter the number of a digital input, a variable or the word ANY. Use of the 
word ANY causes any input (1-8) to evoke the interrupt state. 

On/Off 

Select the state of the input. 

Call Subroutine 

Enter the name of a subroutine that is executed in case of interrupt. 
Execution of the main program is suspended until completion of the 
subroutine. 

Run Subroutine 

Enter the name of a subroutine that is executed in case of interrupt. 
Execution of the main program continues, and the subroutine is spawned 
as a concurrent process. 

 

An interrupt command causes the program to halt the command it is currently executing (which can also 
be a movement or a delay), and to immediately execute the command specified for this interrupt. If the 
specified command is a Call Subroutine, the program resumes from the point where it was suspended, as 
soon as the subroutine completes its execution. If the specified command is a Run Subroutine, the main 
program resumes immediately after the concurrent process is started. 
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‎6.6 Input/Output Commands 

An interrupt command can be disabled and enabled by means of the EI (Enable Interrupt) and DI (Disable 
Interrupt) commands described below. 

For Example: 

 

This inserts the following line of code: 
On input interrupt 1 on call subroutine GET001 

When Input 1 is turned on, the program immediately calls subroutine GET001. If any axes are moving 
when the interrupt occurs, they immediately stop. When the subroutine is completed (Return from 
Subroutine command is reached), the axes reassume the position and status that were interrupted, and 
the program continues from that point. 

Interrupt Commands 

Icon Option Level Description 

 
DI Disable Interrupt 
#  
 

Pro 

Causes the specified input interrupt to become inactive. When an 
interrupt is inactive, it is disregarded until the EI (Enable Interrupt) 
command reactivates it. The command opens this dialog box: 

 

Input Number 

Enter an input number, a variable, or the word ALL. 

Enable/Disable 

Select Enable in order to modify the command. 
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‎6.6 Input/Output Commands 

Interrupt Commands 

Icon Option Level Description 

 
EI Enable Interrupt #  
 

Pro 

Causes the specified input interrupt to become active. The command 
opens this dialog box: 

 

When an interrupt is active, it is waiting for an interrupt status (defined 
using the OI [On Interrupt] command described above). 

Input Number 

Enter an input number, a variable, or the word ALL. 

Enable/Disable 

Select Disable in order to modify the command. 

 
ON Turn On Output # 1,2,Pro 

Sets the state of the specified digital output On. The command opens 
this dialog box: 

 

Output Number 

Select a number or type a variable name. 

The default settings of Digital and On can be changed. 
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‎6.6 Input/Output Commands 

Interrupt Commands 

Icon Option Level Description 

 
OF Turn Off Output # 1,2,Pro 

Sets the state of the specified digital output Off. The command opens 
this dialog box: 

 

Output Number 

Select a number or type a variable name. 

The default settings of Digital and Off can be changed. 

 
AO Set Analog 
Output # 

Pro 

Sets the state of the specified analog output. The command opens this 
dialog box: 

 

Output Number 

Enter a number (1 or 2), or a variable. 

Value Range 

Enter a number between 0 and 255 which corresponds to the output 
voltage. The range of the output voltage is 0-10 Volts.  

The Analog default setting can be changed. 
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‎6.6 Input/Output Commands 

Interrupt Commands 

Icon Option Level Description 

 
AI Set Variable to 
Analog Input # 

Pro 

Sets the value of the specified analog input to a variable. The command 
opens this dialog box:  

 

Variable Name 

Enter the name of the variable. The first character of the name must be 
a letter. 

Analog Input Number 

Enter an input number (1-4) or a variable, where the variable value is an 
integer in the range of 0-255 corresponding to a controller input voltage 
of 0-10 volts. 

See also the description of the Set Variable commands in the preceding 
sections of this chapter. 

 
WN Wait For Digital 
Input # On 

 

Halts program execution until the selected input is switched on. The 
command opens this dialog box:  
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‎6.7 Advanced Commands 

Interrupt Commands 

Icon Option Level Description 

 
WN Wait For Digital 
Input # Off 

 

Halts program execution until the selected input is switched off. The 
command opens this dialog box:  

 

6.7. ADVANCED COMMANDS 

Advanced Commands are displayed in the Command Tree when you select Options | Advanced Options | 
Advanced Commands. The Advanced Commands command tree for the professional level is shown here: 
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‎6.8 Vision Commands 

The Advanced Commands are summarized in this table.  

Advanced Commands 

Command Level Description 

UP Use Parameter Set Pro 

Specifies the Parameter Set to be used. The command opens this dialog 
box:  

 

Open the drop-down list to select the desired Parameter Set and click 
OK. 

See ‎10.2.2 Parameter Set Window on page 94 for further information.  

PV Set Parameter Value Pro 

Sets the value for a selected device parameter by name. The command 
opens this dialog box:  

 

Axis 

Open the drop-down list to select the axis for which you need to change 
the parameter. 

Name 

Open the drop-down list to select the parameter whose value needs to 
be changed. 

Value 

Enter the new value. 

The details of the selected parameter are automatically displayed. 

6.8. VISION COMMANDS 

Vision Commands are displayed in the Command Tree when you select Options | Advanced Options | 
ViewFlex Commands. See the ViewFlex User Manual for full details. 



 

‎6 Program Editing 74 

‎6.8 Vision Commands 

The Vision Commands command tree for the professional level is shown here: 
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‎7.1 Using a Variable Instead of a Numeric Value: 

7. Variable Programming 
The SCORBASE language allows variable programming. Variables allow you to write commands that 
change as the state of the robot or its environment changes during program execution. Therefore they 
are useful for creating loops and subroutines in robot programs.  

To use a variable, it must first be defined using the Set Variable to Computation command. Variable 
names can be up to 22 characters long. It is recommended, however, that you use meaningful names that 
are as short as possible. The first character of the name must be alphabetic. 

SCORBASE has full access to variables in Visual Basic scripts that are loaded in memory. The variable name 
must begin with SCRIPT., for example: SCRIPT.A. Values can be transferred both to and from variables in 
external Visual Basic scripts. 

In most editing commands, a variable can be specified instead of a numeric value.  

A variable cannot be used to specify a Label or a Subroutine. 

If at run time the program encounters a variable whose value is not defined or is out of range, an error 
message is displayed. 

 

7.1. USING A VARIABLE INSTEAD OF A NUMERIC VALUE: 

Example #1  
Set Variable station1=5 

Set Variable lamp=1 

Go to Position station1 fast 

Turn on output lamp 

In this example, one of the robot stations named “station1” is recorded as position #5 and a lamp is 
connected to output #1. When the program initiates, the value (5) is assigned to the variable named 
station1 and the value (1) is assigned to the variable lamp. The following program lines send the robot to 
position “station1” and turn on a “lamp”. Using a meaningful name for the variable makes the 
programming, debugging and maintenance easier. 

Example #2  
Set variable pos = 0 

Start: 

Set variable pos = pos +1  
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‎7.2 Monitoring Variable Value 

Go to position pos fast 

Wait 50 (10ths of seconds) 

If pos < 5 jump to start 

In this example, the robot moves to Positions #1, #2, #3, #4 and #5. At each position, the robot waits 50 
seconds. After waiting at position #5, the program terminates. 

Example #3  
Start: 

Set variable tested = 0 

Loop: 

Set variable tested = tested +1  

If input tested off call sub off 

If input tested on call sub on 

If tested < 8 jump to loop 

Jump to start 

 

Set Subroutine off 

Turn off output tested 

Return from subroutine. 

 

Set Subroutine on 

Turn on output tested 

Return from subroutine 

In this example, the program sequentially scans digital inputs 1 through 8 in an endless loop. 

If the tested input is On, the program turns on the corresponding output. 

If the tested input is Off, the program turns the corresponding output off. 

7.2. MONITORING VARIABLE VALUE 

To monitor a variable value, SCORBASE offers the following tools: 

1. When SCORBASE is running and a Set Variable command is executed, the current value of the 

variable is displayed in the status line at the bottom of the screen. 

2. When the program is not running, click the Set Variable command in which the value is assigned 

to the variable, and then execute this line using the Run Single Line command. The variable value 

is displayed in the status line at the bottom of the screen. 

3. The Print to Screen & Log (PS) command can also be used to print the actual value of a variable, 

by placing the variable name within single quote marks in the text to be printed. 

For example: 
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‎7.2 Monitoring Variable Value 

Set Variable z = 5 

Set Variable x = 9 

Set Variable y = x - z 

Print to screen z=’z’ x=’x’ y=’y’ 

When the program is running, the following messages are displayed in the status bar: 

1. When the first line is executed, the message is z=5. 

2. When the second line is executed, the message is x=9. 

3. When the third line is executed, the message is y=4. 

4. When the fourth line is executed, this window is displayed: 
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‎8.1 Running a Program 

8. Program Execution 
The Program window and the dialog bars described in this chapter are used for activating and monitoring 
program execution. 

Select Window | Run Screen to display only the Program window, which shows the section of the 
program currently executed. 

 Status Bar - indicates the currently executed line or current value of a variable. 

 Inputs and Outputs Dialog Bars - show the Analog Input, Analog Output, Digital Input, Digital 
Output values. To activate the dialog bars that are most useful for program execution, select View 
| Dialog Bars and then the desired dialog bar from the pop-up menu. 

 Log file - records data during program execution. 

8.1. RUNNING A PROGRAM 

SCORBASE offers three modes of running a program. To select the running mode do one of the following: 

 Click the appropriate Run icon in the toolbar.  

 Select one of the Run options in the Run Menu. 

 Press the function key. 

Running a Program Options 

Icon Option (Shortcut) Description 

 
Single line (F6) Runs the currently selected (highlighted) line 

 
Single cycle (F7) 

Runs the program from the currently selected (highlighted) line. 
Running stops after the last line is executed 

 
Continuous (F8) 

Runs the program from the currently selected (highlighted) line. 
After the last line is executed, program execution continues from 
the first line 

Note:  

 The [Run] key on the Teach pendant cannot be used to start execution of SCORBASE programs. 

 Always restart execution of a program from the first line after you have changed program data 
(e.g., recorded new coordinates for a position, edited a program line, etc.). 

8.2. HALTING PROGRAM EXECUTION 

Stop and Pause are the two methods of halting program execution in SCORBASE. 

To stop or pause programs from SCORBASE perform one of the following: 
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‎8.3 Inputs and Outputs Dialog Bars 

 Click the appropriate icon in the toolbar. 

 Select Run | Stop, or Run | Pause. 

 Press F9 / F10. Make sure the SCORBASE application is the currently active window before you 
press F9 (STOP) or F10 (PAUSE). 

 To stop the program, you can also press the red EMERGENCY button on the controller or press 
the ABORT key on the Teach Pendant (if installed). 

Halting the Program 

Icon 
Option 
(Shortcut) 

Description 

 
Stop (F9) 

Program execution is stopped immediately. Use this command only in emergencies. 

If the workstation is connected only to a stationary robot such as an ER-4u, the STOP 
command is sent directly to the device. However, other devices such as the ER-400 
AGV Mobile Robot require the user to define a subroutine with the name ON_STOP. 
When the STOP button or F9 is pushed, the ON_STOP subroutine is called. 

The subroutine might contain a line such as Turn Off Output 1. Here is an example 
for use with the ER-400 AGV Mobile Robot: 

 

 

Pause (F10) 
Stops program execution only after the current command has been executed. Thus, 
axes may continue moving (to complete their motion) after the Pause command is 
issued. 

8.3. INPUTS AND OUTPUTS DIALOG BARS 

8.3.1. Digital Inputs & Outputs Dialog Bars 

The Digital Inputs & Outputs dialog bars show the status of the controller digital inputs and outputs. The 
display is available in all modes of operation. The Digital Input Dialog Bar is shown here: 

 

The Digital Output Dialog Bar is shown here: 

 

In both dialog bars, when the I/O status is Off (false), the matching I/O number is dark green. When the 
I/O status is On (true), the matching I/O number is light green  
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‎8.4 SCORBASE Log File 

If control is On, the sixteen Output / Input LEDs on the front panel reflect the I/O status. 

If control is On, clicking on an output number in the Digital Output dialog bar toggles the status of the 
controller’s digital outputs. 

In Off-Line the Digital Output dialog bar can also be used to simulate the status of controller's digital 
inputs. This option is useful for checking the If Input#_onJump command. 

In On-Line mode, to test the program response for the If Input#_onJump command, short the designated 
input terminal to the digital input ground.  

8.3.2. Analog Inputs & Outputs Dialog Bars 

SCORBASE can monitor and control four (4) analog inputs and two (2) analog outputs. The Analog Inputs 
& Outputs dialog bars show the values of the controller Analog Inputs and Outputs. These dialog bars may 
also be opened or closed using the View | Show All Dialog Bars or View | Close All Dialog Bars 
commands. The Analog Input dialog bar is shown here: 

 

The Analog Output dialog bar is shown here: 

  

The Analog Inputs and Output resolution is 8-bit. The Analog Input / Output range is from 0 (minimum) to 
255 (maximum). 

Output values can only be manipulated when SCORBASE is operating On-Line. To change the value of an 
Analog Output, perform one of the following: 

 Click Output (the color turn from light yellow to white), and type a number. 

 Use the AO Set Analog Output # command. 

When the controller receives an Analog Input signal from an external device, the value (0-255) of the 
signal is reflected in the Input Value field. 
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‎8.4 SCORBASE Log File 

8.4. SCORBASE LOG FILE 

The SCORBASE log file records the messages printed using the PS (Print to Screen Log) command. To print 
to a message to the log file, click either Log File or Screen and Log File. 

 

The Log file is initialized (cleared) each time SCORBASE is loaded. 

To see the file content, open the file SCBS.LOG using a text editor (such as WordPad). The file is located in 
the SCORBASE subdirectory named BIN. 

SCORBASE generates a SCBS.BAK backup file of the SCBS.LOG file each time the program is closed.



 

‎9 Project Files Management 83 

‎9.1 Project Management 

9. Project Files Management 
A SCORBASE project includes the following files: 

 SCORBASE program (file extension *.SBP) 

 Recorded Position files (file extension *.PNT) 

 Project data (file extension *.WS) 

 Graphic image (if RoboCell is installed – file extension *.3DC). 

All commands (except for Open) relate only to the SBP, PNT and WS files. 

Opening or saving a project from the File menu opens or saves all project files (three or four files).  

As default, all files are located in the Projects directory (folder) in the  
ER 2u or ER 4u directory (depending on which robot is being used for the project). 

9.1. PROJECT MANAGEMENT 

SCORBASE project files are managed by means of the standard Windows file tools, which can be accessed 
by icons or via the File menu.  

Project Management Options 

Icon Option (Shortcut) Description 

 
New (Ctrl+N) 

Opens a new, untitled, project. All project-related files are 
created. 

 
Open (Ctrl+O) 

Opens a Load Project File dialog box for opening a 
previously saved project. All project-related files are 
opened. Only one project may be open at a time. 

 
Save (Ctrl+S) 

Saves the currently active project. If the project has not 
previously been saved (i.e., is untitled), a dialog box for 
specifying the project name opens.  

All project-related files are saved, including Program, 
Positions and Graphics. 

 Save As... 

Opens the Save Project dialog box for saving the currently 
active project under a new name.  

All project-related files are saved under that new name. 

As default, all projects are saved in a Projects folder. 

 Close Project Closes the currently open project. 

 New Script 
Opens Notepad. The user can then begin to write a new 
Visual Basic script file. 

 Open Script 
Opens File Selector box for opening an existing Visual Basic 
script file. 
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‎9.1 Project Management 

Project Management Options 

Icon Option (Shortcut) Description 

 Print Program  
Prints the program 

The Program window must be active to select this option 

 Print Positions 

Prints the position table 

The Position window must be open and active to select this 
option. You can open the Position window by selecting 
View | Positions. 

 Print 3D image Prints the 3D image (if RoboCell program is installed). 

 
Print Preview  
3D Image 

Opens a dialog window that shows how the printed cell is 
displayed on paper. 

 Print Charts 
Opens a dialog box to select the specific axis chart for 
display or printout. Only one axis can be selected at a time. 

 Print Preview Charts 
Opens a screen which displays the selected axis chart 
before printout showing how the printed cell is displayed 
on paper. 

 Import 3D Model 
Opens the Import 3D Image dialog window showing the 
graphic module files (*.3DC files). 

 Edit 3D Model Opens the Graphic Module in CellSetup. 

 View File 
Opens the View File window to display the program or 
position of any selected project. 

 Exit 
Quits SCORBASE. If changes to a program or position file 
have been made, but not yet saved, a warning message is 
displayed. 
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‎10.1 Window Layout Options 

10. System Configuration 
SCORBASE offers the following options for system configuration: 

 Window Layout options 

 Experience level 

 Hardware setup 

10.1. WINDOW LAYOUT OPTIONS 

The window layout options are accessible from the Window menu, shown below.  

 

The display options enable optimal usage of the screen area. SCORBASE offers five basic display options 
and a wide range of dialog bars and windows through which the user can see and change system data. 
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‎10.1 Window Layout Options 

10.1.1. Simulation & Teach  

The Simulation and Teach layout is shown here: 

 

Available only if RoboCell is installed, this layout option displays the following windows: 

 Program Window that holds the SCORBASE program. 

 3D Image 

 Manual Movement Dialog Box 

 Teach Positions Dialog Box 

 Workspace Window that shows: 

 Project tab 

 Commands tab 

For further information, see the RoboCell User Manual. 
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‎10.1 Window Layout Options 

10.1.2. Teach & Edit 

The Simulation and Teach layout is shown here: 

 

When a SCORBASE project is opened, the screen is set for the Teach & Edit display mode by default. In 
this mode, these windows and dialog boxes are displayed: 

 Program Window that holds the SCORBASE program 

 Manual Movement Dialog Box 

 Teach Positions Dialog Box 

 Workspace Window that shows: 

 Project tab 

 Commands tab 

To open the Teach & Edit layout, select Window | Teach & Edit. 
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‎10.1 Window Layout Options 

10.1.3. Run Screen 

The Run Screen layout is shown here: 

 

The Run Screen display option opens the Program Window only. When the program is running, the 
currently executed line is highlighted and information on the currently executed command is displayed in 
the status bar. 

To open the Run Screen layout, select Window | Run Screen. 
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‎10.1 Window Layout Options 

10.1.4. Project Screen 

The Project Screen layout is shown here: 

 

The Project Screen option displays the following: 

 Program Window that holds the SCORBASE program 

 Workspace Window that shows: 

 Project tab 

 Commands tab 

 Positions Window 

When the program is running, the currently executed line is highlighted, and information on the currently 
executed command is displayed in the status bar. 

To open the Project Screen layout, select Window | Project Screen. 
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‎10.1 Window Layout Options 

10.1.5. Open CIM Screen 

The Open CIM Screen layout is shown here: 

 

The Open CIM Screen option displays the following: 

 Program Window that holds the SCORBASE program 

 Open CIM Device Driver Window, which provides: 

 Toolbar, with  button for Manual Stop 

 Operation Mode selector 

 Online 

 Simulation 

 Standalone. When this option is selected, you may press the  icon on the toolbar to open 

the TCP/IP dialog box for establishing communications with other Open CIM applications. 

 

 Task History panel 
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‎10.2 Options Menu 

 Percentage Complete from Pick & Place File 

 CIM Messages panel 

 Messages Window 

To use the Open CIM Screen layout, select Window | Open CIM Screen. 

10.1.6. User Screen; Save User Screen 

The User Screen and Save User Screen options can be seen in the Window menu here: 

 

By default, the User Screen displays the same windows as the Teach & Edit Screen. However, the user can 
customize the layout of the windows to the needs of the project. This is useful when you have specified 
one or more dialog bars under the View menu.  

To save the layout for future use, select Window | Save User Screen.  

Whenever you desire to use that layout again, select Window | User Screen. 

10.2. OPTIONS MENU 

The following section covers additional Options menu functions. The Options menu is shown here: 
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‎10.2 Options Menu 

10.2.1. Hardware Setup 

SCORBASE allows you to define the devices that are connected and operated by the controller as Axes 7 
and 8. The following peripherals can be connected to the USB Controller: 

USB Controller Peripherals 

Catalog number Description 

1009 Rotary Table, 24V 

1010 Conveyor Belt (gray), 24V 

1020 1.0m Linear Slidebase, belt-drive, 24V 

1021 1.8m Linear Slidebase, belt-drive, 24V 

1013 Linear Table 0.3m, 24V 

1014 XY-Table, 24V 

1234 Motor Kit 24V 

Note: The following peripherals are not supported: 

 1.0m Linear Slidebase, belt-drive, 24V, Catalog #1018 

 1.8m Linear Slidebase, belt-drive, 24V, Catalog #1019 

Contact your local distributor for further information. 

Do not change the hardware setup unless you are authorized to do so. To define the devices, select 
Options | Hardware Setup. The Hardware Setup dialog box opens (shown below). Click the arrow to open 
the list of available devices, and then click the desired device. 
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‎10.2 Options Menu 

The Hardware Setup Peripherals Dialog Box showing default settings is shown here: 

 

The Hardware Setup option also enables you to work with a different robot from the one you selected 
during installation. To do so, click the Robot radio button. 

 

Select the desired robot and click OK. 
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‎10.2 Options Menu 

10.2.2. Parameter Set Window 

The Parameter Set Window - for Robot is shown here: 

 

The Parameter Set Window - for Axes is shown here. 

 

SCORBASE contains the following parameter sets: 

SCORBASE Parameter Sets 

Parameter Set Description 
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‎10.2 Options Menu 

$2KG Moves objects that weigh about 2 kg. 

$3KG Moves objects that weigh about 3 kg. 

$Current Current parameter set loaded to the controller. 

$Default Default set when parameters are optimized. 

Maxspeed Activates the robot at maximum speed. 

To modify any of the parameters of the above vendor-supplied sets you must save the set under a 
different name. To do so: 

1. Click the Save As icon to open the dialog box.  

2. Enter the name of the new Parameter Set  

3. Click OK to save. 

The Parameter Set Window toolbar is shown here: 

 

Use the Parameter Set Window toolbar to select one of the following options: 

Parameter Set Window Toolbar Options 

Icon Option Description 

 
Open 

Displays the Open Parameter Set window. Select the desired Parameter Set from 
the list. 

 
Save 

Saves the Parameter Set after changes have been affected. 
A Parameter Set marked with the $ symbol cannot be changed and saved. The set 
must first be saved under a new name using the Save As icon. 

 
Save As 

Opens the Save Parameters Set As dialog box. 
Enter the name of the new Parameter Set and click OK to save it. 

 
Default Displays the $Default Parameter Set. 

 
Apply Loads the selected Parameter Set to the controller. 

 
View 

Opens the selected Parameter Set Window, which lists all the parameter keys, 
with description and value, included in the Parameter Set. The keys are listed by 
sections. 

10.2.3. Line Number 

The Line Number option is shown in the Options Menu, below.  
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‎10.2 Options Menu 

 

By default, SCORBASE displays program line numbers in the Program Window. If you wish to hide them, 
uncheck the toggle under Options | Line Number. 

10.2.4. Reload Last Project at Startup 

The Reload Last Project at Startup option is shown in the Options Menu, below.  

 

When SCORBASE is initiated, the program can be set up to automatically open the last project. To toggle 
this option, select or deselect Options | Reload Last Project at Startup. A checkmark next to this option 
indicates that the option is on. 

10.2.5. Experience Level 

SCORBASE offers three experience levels: 

 Introductory (Level 1) 

 Advanced (Level 2) 

 Professional (Pro Level) 
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‎10.3 View Menu 

A higher level offers more commands and tools. Levels can be selected from the Tool bar or from the 
Options menu. 

Experience Levels 

Icon Level Description 

 
Level 1 

Displays list of commands and options at introductory level. Commands related 
to Level 2 and Pro are disabled. 

 
Level 2 

Displays list of commands and options at advanced level. Commands related to 
Pro are disabled. 

 
Pro Displays list of all commands and options. 

Display of the Advanced Commands and the Vision Commands is activated by selecting Options | 
Advanced Options. 

10.3. VIEW MENU 

The following display options are available from the View menu: 

View Menu Options 

Option Description 

Movement information 

The Movement information dialog box, shown below, displays the following: 

 Position error for all eight axes 

 Home switch status (for all eight axes). The number 1 indicates the switch is on 
(pressed) while 0 indicates the switch is off (released). 

 Selected axis (1 – 8) PWM value. The PWM value indicates the power sent to the 
axis motor.  

 

Messages 

The Messages dialog box, shown here, displays the content of the PS (Print To 
Screen) commands.  

 

These two commands produce a window which overlaps the existing windows. The user should readjust 
the positions and sizes of these windows according to personal preference. 
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‎10.3 View Menu 

10.3.1. Dialog Bar Display Options 

All Dialog bars are accessible from the View menu. Select View | Dialog Bars. 

Dialog Bar Display Options 

Option Description 

Joints 
Shows angle of the robot joints. For more information, see ‎5.10.3 Joints Dialog Bar on page 
40. 

XYZ Shows position coordinates of the TCP. See ‎5.10.2 XYZ Dialog Bar on page 40. 

Digital output 
Shows digital output status and enables toggling an output status. For more information, 
see ‎8.3.1 Digital Inputs & Outputs Dialog Bars on page 80. 

Digital input 
Shows the digital input status. Enables toggling an input status in Off-Line mode, for 
program debugging. For more information, see ‎8.3.1 Digital Inputs & Outputs Dialog Bars 
on page 80. 

Analog output 
Displays the value (0-255) of Analog output 1 and 2. These values can also be modified 
through this dialog bar. For more information, see ‎8.3.2 Analog Inputs & Outputs Dialog 
Bars on page 81. 

Analog input 
Displays the value (0-255) of Analog inputs 1-4. Enables setting a value for an input in Off-
Line mode, for program debugging. For more information, see ‎8.3.2 Analog Inputs & 
Outputs Dialog Bars on page 81. 

Encoders 
Shows the values of the eight encoders. For more information, see ‎5.10.1 Encoder Counts 
Dialog Bar on page 39. 

Each of these options adds a dialog bar to the bottom of the screen, overlapping whatever windows are 
displayed. The user can retile the screen by reselecting the desired Window Layout Options from the 
Window menu.
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11. Appendix: Command Line Options 
The following table describes the command line options that enable the integration of user applications 
with SCORBASE.  

Before operating SCORBASE with these command line options, follow and obey all warnings and cautions 
provided in the user application manuals to prevent, for example, hazards from moving parts. 

The SCORBASE command line format that is required when using the options described in the table is 
provided, as follows:  

SCORBASE.EXE [Optional INI File] [Optional Switches] 

 

Command Line Options 

Option  Description 

/O 
Loads SCORBASE in online mode.  
For example, SCORBASE.EXE SCBS.INI /O  

/S 
Loads SCORBASE in simulation mode. 
For example, SCORBASE.EXE SCBS.INI /S 

/H 
Performs auto homing from online mode. 
For example, SCORBASE.EXE SCBS.INI /H 

/L 
Loads a specific workspace in simulation mode.  
For example, SCORBASE.EXE SCBS.INI /L=“C:\PROGRAMES\INTELITEK\ 
ROBOCELL\PROJECTS\ER4u\Er4Cell1.WS” 

/R 

Loads a specific workspace and runs SCORBASE.  

For example, SCORBASE.EXE SCBS.INI 
/R=”C:\PROGRAM FILES\INTELITEK\ROBOCELL\ 
PROJECTS\ER4u\Er4Cell1.WS” 

/I 
Open CIM Robot Device Driver configuration file. 

For example: SCORBASE.EXE /I=USBVD1.INI 

/N Open CIM Robot Device Driver number. 

/T Displays the SCORBASE application on top of the desktop at all times. 

/U Prevents the SCORBASE application from staying on top of the desktop. This 
command can be activated only when SCORBASE is open.  

/M Minimizes the SCORBASE application. This command can be activated only 
when SCORBASE is open. 

/E Restores the SCORBASE application. This command can be activated only 
when SCORBASE is open. 

/C Closes the SCORBASE application. This command can be activated only when 
SCORBASE is open. 
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Examples of SCORBASE command line procedures are provided, as follows: 

Loading a workspace in simulation mode: 

 At the prompt, type the following: 
SCORBASE.EXE /S /L=”C:\PROGRAM FILES\INTELITEK\ 
ROBOCELL\PROJECTS\ER9u\Act3.WS”. The workspace is loaded in simulation mode.  

Loading the software in online mode and homing the robot:  

 At the prompt, type the following: 
SCORBASE.EXE /O /H /R=”C:\PROGRAM 
FILES\INTELITEK\ROBOCELL\PROJECTS\ER4u\Er4Cell1.WS”. The workspace is loaded in online 
mode and the robot is homed. 

/CIMDD_ONLINE Open CIM-SCORBASE device driver mode: Online 

/CIMDD_SIMUL_AUTO Open CIM-SCORBASE device driver mode: Simulation 

/CIMDD_STANDALONE_ONLY Open CIM-SCORBASE device driver mode: Standalone 
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